
Known Bugs

The following is a list of known bugs in the May 1995 release of HiJaak Graphics Suite.

HiJaak Browser
 HiJaak Browser cannot create viewable thumbnails for a CD-ROM with no volume label.
 If you have two drives with the same serial number, Browser treats them as the same drive. Therefore, 

if you update images on the second drive HiJaak Browser will look for them on the first drive and will not 
be able to find the files.

 HiJaak Browser cannot read EPS printer files.
 HiJaak Browser cannot read all files created by HiJaak Draw.
 HiJaak Browser does not recognize stacked drives partitioned into multiple drives with Stacker; it 

recognizes only the first drive, not the partitions. For example, if you used Stacker to partition your hard 
drive into drives C:, D:, and E:, HiJaak Browser will only recognize the C: drive.

 HiJaak Browser does not recognize Lantastic network drives. 

HiJaak Draw
 If you drag a PDW file onto the HiJaak Draw icon in the Browser application bar, the HiJaak Draw title 

bar will display UNTITLED.PDW as the name of the file.

HiJaak PRO
 If you are running Windows in 65K colors, HiJaak PRO will not capture the cursor on a Windows 

capture.
 If you are viewing an image using the Image Only, running Windows in 65K color, and are using a 

Diamond Graphics driver version 1.22, HiJaak PRO will hang on exit.
 HiJaak PRO cannot read all files created by HiJaak Draw.
 HiJaak PRO cannot read EPS printer files.

HiJaak Paint
 The Epson GT8000 scanner does not work with TWAIN
 If the AUTO option is selected, the new HP Scanjet scanners will not work with TWAIN.

HiJaak Smuggler
 HiJaak Smuggler cannot read EPS printer files.



Troubleshooting, Tips and Tricks for Using HiJaak Graphics Suite

If you are having problems using HiJaak Graphics Suite, or if you are getting unexpected results, you can 
find possible solutions in this help file. Click on the application in the HiJaak Graphics Suite for which you 
want to find troubleshooting help:

Troubleshooting HiJaak Browser
Troubleshooting HiJaak PRO
Troubleshooting Smuggler
Troubleshooting HiJaak Paint
Troubleshooting HiJaak Draw
Known Bugs

Hint: If you are having problems using the products in the HiJaak Graphics Suite together, look into the 
Troubleshooting HiJaak Browser help for information.





Troubleshooting HiJaak PRO

If you are having problems using HiJaak PRO, or if you are getting unexpected results, you 
can find possible solutions in this help file. For troubleshooting help, click on one of the 
following topics: 

Running HiJaak PRO
Basic Look of an Image
Clipboard Support
Colors
Conversions
DOS Capture
Error Messages
Import into Other Applications
Macintosh Files
Opening
Printing
Scaling and Resizing
Text and Fonts
Trace
TWAIN
Windows Capture
It used to work, and now it doesn't?

Note: This Troubleshooting help file is dated 9/15/94. An updated version may exist on the 
Inset Systems BBS. It can be reached 24 hours a day at 203-740-0063.    You may also obtain
an updated Troubleshooting file by logging on to CompuServe and typing GO INSET.



Running HiJaak PRO
Q. HiJaak PRO GPFs in RDM330 when I try to run it. What should I do?
A. The HiJaak Browser Index has become corrupt. This corruption causes HiJaak PRO and 

Smuggler to GPF as well as HiJaak Browser. To solve this problem, go to the DOS prompt 
where you installed HiJaak Browser and type KEYBUILD followed by the path to your 
HiJaak Browser Index. If you installed in the default directories, you would type the 
following command at the C:\INSET DOS prompt:

KEYBUILD C:\INSET\BASE
          If you are using an Index other than the default, replace "BASE" with the name of your 

Index.

Q. When I try to run HiJaak PRO, I get the message "Cannot find GPIB.DLL." What 
should I do?

A. Delete C:\WINDOWS\HJPRO.SET. Then, open C:\INSET\HJPRO.ORG in an ASCII editor. At the
end of the HJPRO.ORG, type the following line:
TWAIN=OFF
Save the file and try to run HiJaak PRO again.



It used to work, and now it doesn't?
If you are trying to perform an operation that has worked properly in the past, but doesn't 
seem, to be working now, the most probably cause is that your HJPRO.SET set file has been 
corrupted. To fix this problem, pull down the Setup menu and click on Load Settings 
(Alt+s, l). In the Load Settings dialog box, click on Defaults (Alt+f). Click on OK. Restart 
HiJaak PRO and try the operation again.

If you are working with PCL files, run the RESETPCL.BAT utility, located in the INSET directory.
This utility clears up old font information. To use it, exit HiJaak PRO and go to a DOS prompt. 
Type RESETPCL with the path to your Windows directory (typically C:\WINDOWS) as the 
command line parameter.

If this does not work, other important program files may have been corrupted or deleted. Try
re-installing HiJaak PRO.



Basic look of an image
Problems with the Way Your Image Looks
If your opened, processed or converted image doesn't look the way you expect it to, there 
may be a way to fix it.    Click on one of the following topics for more information.

Parts of my image are missing
My rotated image doesn't look right
Undo doesn't undo all my changes
Every image I open looks bad

Note: If your image looks bad after performing multiple processing operations on it, try 
saving and re-opening the image between each operation.



Parts of my image are missing
Q. Why are some elements of my vector image missing?
A. If elements (lines, arcs, etc.) the same color as the background are not visible, use 

Reveal Background Color Objects to restore the image. This option sets initially 
invisible objects to a color that contrasts with the background.

Q. Why does changing my color raster image to black and white result in the loss 
of part(s) of the image?

A. If you try to force a raster image to black and white, it may appear to lose some part(s) of
the image, or even result in an all black or an all white image.    This may indicate that 
HiJaak PRO's selection for what colors to make black and what colors to make white is 
inappropriate for the image you are working with.    Use the Change a Color option from 
the Colors menu to manually change your colors to the appropriate black and white 
output.    HiJaak PRO remembers your color changes, and gives you the option to apply 
them in future similar conversions.



My rotated image doesn't look right
Q. Why does my DOS text screen capture display incorrectly when I rotate it in 

HiJaak PRO?
A. HiJaak PRO is capable of rotating text screen captures in increments of 90 degrees 

without distorting the images. Other rotation values could cause image quality to suffer.

Q. After I rotate my PCL file, why do my fonts change?
A. The PCL4 used by HiJaak PRO in emulation of the LaserJet II does not provide for the 

rotation of fonts. HiJaak PRO substitutes an already-rotated font whenever text in a PCL 
file is rotated. That may cause the look of the PCL file to change. To avoid the change in 
font, convert the PCL file to PCX and then back to PCL. The conversion through PCX will 
cause text to become bitmapped representations of the original font. Subsequent rotation
of the PCL file will not change the appearance of the text.

Q. Why does a colored background appear when I rotate an image after using the 
Optimize Palette option on it?

A. When an image is rotated a number of degrees that is not an even multiple of 90, the 
resulting image will no longer fit into the rectangular window available for it. HiJaak PRO 
must pad the image with pixels of a certain color to fill out the rectangular window. 
Whenever possible, HiJaak PRO will fill out the image with the background color selected 
under Setup and Preferences. However, if palette optimization is used on an image before
rotation, the optimization may, in fact, eliminate the background color from those 
available for the particular image. Another background color -- one that is available in the 
new optimized palette -- is selected to fill out the image window. To ensure that no color 
substitution takes place, rotate the image before selecting optimize palette. Performing 
the rotation first will introduce the background color into the image and it will be 
preserved as part of the palette through the optimization process.



Undo doesn't undo all my changes
Q. The Edit/Undo menu item appears to undo only the last change I have made to 

my raster image. Is there a way to undo all the changes I have made?
A. The Undo option for raster images is limited. If you will be performing multiple 

processing options on a raster image, you may want to select View/ Clone View first 
(Alt+v, l). Clone View creates an on-screen copy of your active image. You can then 
process the clone and compare its quality to the original. If you wish to discard changes 
you have made to the clone, simply close the clone image.



Every image I open looks bad
Q. Why does every image I open look bad?
A. HiJaak PRO may be having difficulty determining the proper display card type. Use the Display 

Type dialog box in the Setup menu or by running HJSETUP to fix this problem. For mroe 
information on selecting Display Type, click on the following:
Display Type

Q.    Why do I get vertical stripes in my images when I open them in HiJaak PRO?
A.  We know that this problem sometimes occurs with the #9 S3 video card when Bitmap 
Caching is enabled. Changing the setup of your video card can help: from your #9 S3 video 
card setup program, disable Bitmap Caching. Restart Windows and HiJaak PRO and open an 
image. It should now view properly.



Clipboard Support

Q. When I use HiJaak PROs Copy As command and select the TIFF format, I get an error when I try
to paste into my application. How can I successfully select a format and paste an image?

A. Since some applications cannot read TIF from the Clipboard, you should select another format.    In the
Select Clipboard Format dialog box, select Windows DIB. This should consistently give you good 
results.

Q. Why do I get an "Error -1017: Source Corrupt or Unsupported" when I try to paste an image I 
have copied to the clipboard in a specific format using the Copy As command? 

A. Although HiJaak PRO allows you to select the format in which you want to copy your image to the 
Clipboard, the format you select must be compatible with the images original format. For example, if 
you choose to copy a PCX file to the Windows Clipboard in TXT format, you will get this error because 
PCX files do not contain TXT information. If you want to copy a raster image to the Clipboard, select a 
raster format. If you want to copy a vector image to the Clipboard, select a vector format. Only select 
TXT if your image is in TXT format. If you do not know which format to select, leave the Select 
Clipboard Format dialog box alone. HiJaak PRO will provide the image to the pasting application in 
whatever format the application requests.

Q. After I copy an image from HiJaak to the Windows Clipboard and then paste that image into an 
application, I get inconsistent results. Why does the image look good in some applications and
bad in others? 

A. When you paste an image into an application, the pasting application requests HiJaak PRO to give it 
the image in either a BMP or WMF format. If the pasted image looks bad, then the application 
probably requested a WMF file. By default, HiJaak PRO sends WMF files in 16 colors. You can set 
HiJaak PRO to send the WMF file in 256 or even 16 million colors.
To do this, pull down the HiJaak PRO File menu and click on Command, You will see the Command 
dialog box. Type the following command:
WMFDEP=XX, where XX can be equal to any of the following values:

4 (default 16 colors)
8 (256 colors, recommended)
24 (16 million colors, can be very slow)



Colors

HiJaak PRO Problems With the Colors in an Image
If the colors in your image do not look right, click on the problem below that most closely matches your 
situation:

The colors in my images are all wrong!
The image has strange patterns throughout
The image is too light or too dark
The image looks like a photo negative
Invert colors doesn't seem to be working right
My black and white print-outs of color images look bad
My color changes don't appear correctly or colors seem to be changing for no reason
My grayscaled image looks bad
Palette Optimization seems to have no effect
Reverse Black and White seems to have no effect
When I reduce colors, the image looks bad



The colors in my images are all wrong!

Q. Why does every image I open seem to have the wrong colors?
A. HiJaak PRO may be having difficulty determining the proper display card type. Use the Display Type 

dialog box in the Setup menu or by running HJSETUP to fix this problem. For mroe information on 
selecting Display Type, click on the following:
Display Type



The image has strange patterns throughout

Q. Why is there a box-like pattern in my image?
A. Using Dither in HiJaak PRO not only "blends" colors from the Windows palette to approximate the 

colors of your original image, but it blends them in a distinct pattern.    If this box-like pattern is very 
obvious, you may want to use Diffuse, which blends colors from the Windows palette in a more 
random pattern. Note that Diffuse takes longer to process.

Q. Why is HiJaak PRO's default Reduction Method set to Dither?
A. HiJaak PRO uses Dither because it's the quickest way to get the best display of images that contain 

more colors than are available in your Windows palette. Snap is faster than Dither, but the results 
aren't as good.

Q. Why are there "worming" patterns in my image?
A. When using the Diffuse option, this is always a potential problem. Use the Dither option and see if you

get better results. Colors in your image that are not available in your Windows palette must be 
approximated using either Dither or Diffuse patterns. Choose the one which gives you the best 
results.



The image looks too light or too dark

Q. How do I convert a captured screen with a dark-colored background to grayscale and get an 
image that is not too dark?

A. Set Brightness up to +15 or +20 to lighten the image overall.    If only the foreground is too dark, use 
Contrast at about +15 or +20 to lighten the foreground.

Q. How can I lighten the middle-range of colors, while leaving extremely light and extremely dark 
areas alone?

A. To lighten mid-range areas, increase the Gamma Correction. Pull down the Colors menu and select 
Contrast and Brightness (Alt+o, b).    In the Contrast and Brightness dialog box, increase the 
Gamma Correction until the thumbnail looks as you want your image to look.    Click on OK.

Q. My image appears to be all approximately the same muddy color.    How can I see the 
differences in the colors more clearly?

A. When the tones represented in your image appear to be basically the same color or colors throughout 
the image, use Histogram Equalization to perform an analysis of the tones and separate them evenly
to produce a clearer-looking image. Pull down the Colors menu and select Contrast and Brightness 
(Alt+o, b).    In the Contrast and Brightness dialog box click on the      Histogram Equalization check
box (Alt+q). Note that this option will have little effect on images in which the tones are already spaced
evenly.

Q. Why does the color white sometimes appear as a light pattern in my printouts?
A. What shows up on your monitor as white may, in fact, be slightly off-white or a light gray. Because it 

usually has just black ink or black toner to represent shades, your printer must show the light gray as a
halftone pattern. The halftone patterns generated on high resolution output devices, such as image-
setters, will produce good-looking, highly accurate results. On lesser resolution devices, it may be 
necessary to experiment with different brightness setting to produce the best printed results.



The image looks like a photo negative 

Q. Why does my displayed image appear as a photographic negative?
A. In certain situations, the color palette is inverted producing the effect of a photographic negative.    Pull 

down the Colors menu and select Invert Colors to restore the proper colors (Alt+o, i).



Invert Colors doesn't seem to be working right

Q. Why is the Invert option switching black and white to other colors    instead of reversing them?
A. Invert is used not to reverse black and white, but to invert the entire color palette.    If you need to 

interchange black with white, pull down the Colors menu and select Reverse Black and White (Alt+o,
r).



My black and white print-outs of color images look bad 

Q. How do I achieve the clearest possible black and white printout of a color line-drawn vector 
image?

A. Pull down the Colors menu and select All Colors to Black (Alt+o, c); every non-white object in a 
vector image will become black.    A printout will show solid black objects and lines.

Q. How do I get a clear black and white printout of my raster image?
A. If you are printing to a dot matrix or LaserJet printer, select the Grayscale option and click on the 

Reduce Colors button.    In the Reduce/Expand Colors dialog box, select Number of Colors=2, and 
a Reduction Method of Snap. HiJaak PRO will look at the colors in the file and determine whether 
they are closer to white or black and snap each color to either black or white.    For instance, yellow is 
closer to white and will become white.    Blue is closer to black and will become black.    If you were to 
use All Colors to Black instead of the options listed above, you will most likely get an all black image. 

A. If you are printing to a PostScript language printer, select the Grayscale option, but leave the Number 
of Colors the same using the Snap Reduction Method.

Q. Why does the color white sometimes appear as a light pattern in my printouts?
A. What shows up on your monitor as white may, in fact, be slightly off-white or a light gray. Because it 

usually has just black ink or black toner to represent shades, your printer must show the light gray as a
halftone pattern. The halftone patterns generated on high resolution output devices, such as image 
setters, will produce good-looking, highly accurate results. On lesser resolution devices, it may be 
necessary to experiment with different brightness setting to produce the best printed results.



My color changes don't appear correctly, or colors seem to be changing for no 
reason

Q. Why does changing a color in my 24-bit raster image change other similar colors too?
A. This is a feature of the Change a Color option which will change the color you select, as well as 

change similar colors within a certain tolerance.    Because 24-bit images commonly have gradient fills 
that are nearly undetectable, this allows you to change the whole area with only one color change.

Q. Why does HiJaak PRO appear to be changing the colors of some objects in my DXF file?
A. DXF images will open with Reveal Background Color Objects selected as default, mimicking the 

behavior of AutoCAD.    If there are objects the same color as your chosen background, HiJaak PRO 
will automatically change those objects to a contrasting color so they are visible.

Q. Why do I get unexpected results when I change colors in my DXF file?
A. Because HiJaak PRO mimics AutoCAD's default of Reveal Background Color Objects, when objects

would otherwise blend into the background color, it will sometimes respond unexpectedly to a color 
change that is to be performed on an already changed object or line.    Though an object may appear 
to be one color on-screen when performing a color change, the HiJaak PRO color selector is reporting 
the true object color as indicated in the image file.

Q. Why aren't the colors in my 256 color image viewing properly?
A. If you are using a standard Super VGA graphics card and you are not running Windows in a 256 color 

mode, you will not be able to view an image with 256 colors properly.    Windows cannot supply 
enough colors from its palette for HiJaak PRO to view it properly.

          Either select a graphics mode from Windows Setup that supports 256 colors (if your graphics card 
supports it), or display the image using the Reduction Method of Dither or Diffuse in HiJaak PRO.    
Reduction methods will not display exact colors, but will blend the colors available in the Windows 
palette to produce a more attractive image.

A. ATI Ultra graphics cards with Mach32 drivers have an option to turn off the 256 color palette.    With the
256 color palette turned off, HiJaak PRO will not view the colors properly.

Q. Why does a colored background appear when I rotate an image after using the Optimize Palette
option on it?

A. When an image is rotated a number of degrees that is not an even multiple of 90, the resulting image 
will no longer fit into the rectangular window available for it. HiJaak PRO must pad the image with 
pixels of a certain color to fill out the rectangular window. Whenever possible, HiJaak PRO will fill out 
the image with the background color selected under Setup and Preferences. However, if palette 
optimization is used on an image before rotation, the optimization may, in fact, eliminate the 
background color from those available for the particular image. Another background color -- one that is
available in the new optimized palette -- is selected to fill out the image window. To ensure that no 
color substitution takes place, rotate the image before selecting optimize palette. Performing the 
rotation first will introduce the background color into the image and it will be preserved as part of the 
palette through the optimization process.

Q. I've used Change a Color to change color A to color B but then decided to reverse the process 
by using Change a Color to set color B back to Color A. Now whenever I perform any 
processing on my image I see it repaint first in color A then Color B and then Color A again. 
How can I halt this process?

A. Color changes in HiJaak PRO do build one upon another. To eliminate the repaints, you must also 
eliminate the color changes that are causing the repaints. Do this by selecting List Color Changes 
from the Colors selection on the Main menu.



Palette Optimization seems to have no effect

Q. Why doesn't Palette Optimization improve the output image?
A. Palette Optimization only has an effect if you reduce the number of colors in the output image.



Reverse Black and White seems to have no effect

Q. I selected Reverse Black and White and it did not have any effect on my image.
A. Often colors that appear to be black or white are actually not true black and true white.    Reverse 

Black and White only reverses true black and true white.    If this option seems to have no effect on 
your image, you probably don't have any black or white in the image. The colors that appear as black 
and white probably do because your image has more colors than can be displayed; therefore, very 
dark colors will be represented on the display as black, and very light colors will be represented in the 
display as white.



When I reduce the Number of Colors, the image looks bad 

Q. How do I reduce the number of colors and still get an attractive image?
A. If you wish to reduce a 16 million color image to 256 colors, you should use HiJaak PRO's different 

palette options to get the best results.    Use the Reduction Method of Dither or Diffuse, and select 
the Optimize Palette option from your Reduce/Expand Colors dialog box for best results.



 My grayscaled images look bad

Q. Is one format better to use for grayscaling?
A. The TIFF format supports entirely grayscale palettes, and so is much better to use when converting to 

grayscale images.    Other formats such as PCX must use combinations of black and white to 
approximate grays.

Q. Why do I occasionally see strange colors appearing in my image when I make it grayscale?
A. The presence of non-gray colors in a grayscale image will occur most often when dealing with 16-color

images or running Windows in a 16-color graphics mode. There may be no grays or few grays in the 
palette available to HiJaak PRO in those circumstances. HiJaak PRO is forced to substitute another 
available color for the unavailable gray or grays.



DOS Capture
Problems when trying to use DOSCAP
Certain system configurations and applications may interfere with the operation of HiJaak 
PRO's DOSCAP utility.    For advice on dealing with problems, click on one of the following 
topics:

DOSCAP error messages
DOSCAP's limitations
DOS screen captures don't look right
General problems capturing DOS screens
Problems converting DOS screen captures
Problems running DOSCAP
If all else fails...



DOSCAP's Limitations
Q. On what networks does DOSCAP run?
A. HiJaak PRO and DOSCAP support Novell Netware up to and including V3.12.    Other 

networks have not been tested, therefore, use of HiJaak PRO with other networks may not
be supported.    
The only known limitation with the Novell network is an incompatibility between DOSCAP 
and the Token Ring driver. Using the Token Ring driver, you may be allowed to capture 
from and save to local drives, but not to network drives.

Q. Does DOSCAP run with DCA Irma boards?
A. DOSCAP is not compatible with DCA Irma boards.

Q. Can I capture screens with DOSCAP while connected to another computer?
A. Using DOSCAP to capture screens from remote control or communications software, while

you have an established connection, may result in a disconnection.    If this is the case, set
the modem so that the Carrier Detect is HIGH, and try again.

Q. Can I using DOSCAP with 4DOS?
A. 4DOS by J.P. Software can be configured to swap itself to disk when EMS or XMS is not 

available. This disk swapping conflicts with HiJaak PRO DOSCAP and may cause a system 
crash. To avoid this situation, configure 4DOS to swap to EMS or XMS or remain resident.



DOS screen captures don't look right
Q. Why does my DOS text screen capture display incorrectly when I rotate it in 

HiJaak PRO?
A. HiJaak PRO is capable of rotating text screen captures in increments of 90 degrees 

without distorting the images. Other rotation values could cause image quality to suffer.

Q. Why do the characters in the DOS text screen I captured show up differently in 
HiJaak PRO?

A. HiJaak PRO internally maps the captured on-screen characters to a special font. If the font
used by HiJaak PRO does not contain appropriate characters for your screen capture, the 
image generated will be inaccurate. In order to produce a more accurate image of your 
screen, pull down the Capture menu and select DOS Capture Options (Alt+c, d)    Click 
on the Rasterize Text check box (Alt+r) in the DOS Capture Options dialog box. Then 
try capturing the screen again. With this option selected, DOSCAP will take a graphical 
picture of the characters on the DOS text screen you are capturing. That will eliminate the
need for the internal font mapping usually performed within HiJaak PRO. 

Q. How can I change fonts in a DOS text screen capture?
A. HiJaak PRO does not currently permit the changing of fonts in a DOS text screen capture. 

In order to change the font, convert the image to the TXT format first. You can then 
change the fonts in the converted file. Note that all color will be lost.

Q. Screen captures brought into PageMaker as TIFF images sometimes come in 
with black and white reversed. What can I do to fix the image?

A. Selecting Image Control under PageMaker's Element menu will allow for brightness and
contrast and other adjustments to your placed image. Selecting a contrast of -50 will 
reverse black and white in your image.

Q. Why do the scaling options "Page in Width" and "Scale to Window" not work 
with DOS text screen captured IGF images?

A. Due to limitations inherent in the rendering of Windows TrueType fonts, HiJaak PRO does 
not support the use of those scaling options for text screen IGF files.

Q. How can I change a DOS screen capture from Color to Black and White?
A. Pull down the Setup menu and select Load Settings. Click on the Defaults button.
2.    With the IGF image that you want to change open and active, pull down the Colors 

menu and select Change a Color. 
3. Click on the object in the foreground that you want to change to black (ie text).    You will 

see the Colors dialog box. Select black.
4. Repeat step 3 for every color in the foreground that you want to appear black (i.e. text 

and borders).
5. Use Change a Color to change the background to white.
6. Once this is complete, close the IGF image down WITHOUT saving it.    (DO NOT SAVE THE 

IMAGE AT THIS POINT.)
7. Reopen the IGF image. Pull down the File menu and select Save As. You will see the 

Save As dialog box.
8. Select the format to which you want to save the IGF file (i.e. PCX) Click on the Options 

button. You will see the Options dialog box.
9. Click on the List Color Changes button.    You will see the List Color Changes dialog 

box. Verify that the changes you had made are there and correct and then click on the 
Apply Color Changes check box.    Click on OK

10. Click on the Reduce Colors button. You will see the Reduce/Expand Colors dialog 
box. In the Number of Colors field, select    Black and White.    In the Reduction 



Method area, select Snap.    Click on OK.
11. Click on OK two more times to start conversion. Open the converted image and it should

have a black foreground and white background.
12. Once the conversion is complete, select Save Settings from the Setup menu. Save the 

options you set in a set file. For more information on saving settings, click on the 
following:

Set Files



General problems capturing DOS screens.
Q. Why doesn't DOSCAP capture the screen from my application when I press the 

hotkeys?
A. DOSCAP may be unable to capture screens from DOS applications running in "protected 

mode." AutoCAD typically runs in protected mode. A similar mode is used by Lotus 1-2-3 
when using the WYSIWYG interface. In many cases, it is possible to disable protected 
mode. (AutoDesk technical support may have advice on running AutoCAD in "real mode.")
Inset Systems provides an alternate DOS screen capture utility for use when protected 
mode cannot be disabled. For more information, click on the following:

If all else fails...
          DOSCAP will also be unable to capture from graphics mode programs compiled with 

Borland Turbo Pascal v5 and higher, because those programs bypass the capturing 
mechanism used by DOSCAP.

A. This may also happen if you are running a terminal emulation application. Try running a 
Windows-based terminal emulator and capture that screen using HiJaak PRO's Windows 
Capture. This should work when the DOS capture fails.

A. This may also happen if you are communicating by modem. Try using a different 
communications package, which may not experience the same interrupt conflicts.    Telix, 
a shareware terminal package by Exis, Inc.,    is available on our BBS and has tested 
successfully with DOSCAP.

Q. How can I use HiJaak PRO to capture a screen from a DOS application that is 
incompatible with DOSCAP?

A. If you can't use DOSCAP with your DOS application, but you can run the application under
Windows in full screen mode, press the Print Screen key to copy the image to the 
Windows Clipboard.    You can then paste the image into HiJaak PRO for conversion.    Text 
screens will be black and white.    Use the "OEM TEXT" option in the Clipboard Viewer to 
display the text properly.

Q. Why don't my capture hotkeys work?
A. If you are running a terminal emulation program, and DOSCAP does not pop-up when the 

hotkeys are pressed, it usually means that the emulation program has the keyboard 
interrupts and has remapped the keys; DOSCAP does not have access to them. 

A. If you are running a Terminate and Stay Resident program (TSR), your hotkeys may not 
activate DOSCAP. A TSR is a program that runs in memory, waiting for you to signal it to 
start by pressing a certain combination of keys or by running a command.    Many screen 
capture and file finding programs are TSRs.    If you are running a TSR, unload it and try 
your DOSCAP hotkeys again.

Q. My graphics card is not listed in DOS Capture Options in HiJaak PRO.    What 
graphics card type should I select?

A. If you do not find your graphics card listed in the DOS Capture Options dialog box, 
select IBM-VGA.    This should work in most cases, except when running a DOS 
application that runs in a high resolution graphics mode.

A. If you do not find your graphics card listed in the interface, find out what chipset it uses 
and select a driver that uses the same chipset.    If you are unsure of which available 
driver to select, call Inset Systems Technical Support.

Q. I cannot capture screens from a DOS application that I wrote. What should I 
do?

A. If you cannot capture screens from an application that you wrote, then your program is 
probably using some of the same interrupts as DOSCAP. DOSCAP uses 08h, 09h, 10h, 17h,
21h (hexadecimal) and all null pointers. If possible, eliminate these interrupts from your 



program and try using DOSCAP again.



Problems converting DOS screen captures
Q. How might I speed up the conversion of text screen capture IGF files to other 

formats?
A. The conversion of text screen capture IGF files to other formats will be particularly time-

consuming when the captured screen includes the dotted text characters often used in 
screen backgrounds and shading. Each dot in those characters must be mathematically 
calculated and positioned by HiJaak PRO during a conversion. To speed the conversion, 
select Rasterize Text from the DOS Capture Options dialog box. Then try capturing 
the screen again. This will cause DOSCAP to take a bitmapped picture of the objects on 
your DOS text screen and will eliminate the need for much of HiJaak PRO's conversion 
calculations. 

Q. My DOS text screen capture does not include any peculiar shading characters 
or anything that should hold up the conversion process. Why else might 
conversions from text IGF files take too long?

A. Through the course of revising the text IGF format for this release of HiJaak PRO, two 
separate fonts were created by Inset Systems. The first, IBMPCMED, was made available 
to users of HiJaak for Windows 1.0 to remedy some text screen capture problems that had
been encountered and was also included in some pre-release testing of HiJaak PRO 
Version 2. That font was later replaced by IBMPCDOS, a TrueType font. If you are among 
those users who received IBMPCMED, it is possible that the presence of that font is 
slowing down IGF conversions and hurting the quality of those conversions. Check for the 
presence of the font using the Fonts selection under the Windows Control Panel. If you 
find IBMPCMED, remove it using the appropriate Control Panel button. Control Panel also 
provides you the option of deleting the font from your hard drive. We suggest you do so. 
The installation of HiJaak should place the newer IBMPCDOS.TTF into your list of available 
fonts. Using this font, HiJaak PRO will be able to give you the best quality conversions of 
your DOS text screen captures in the least time.

Q. How can I avoid a Font File Not Found error message when converting from a 
text screen capture IGF file?

A. That error message should only occur if the font IBMPCDOS.TTF was not properly installed
into Windows during the HiJaak PRO Setup process. HiJaak PRO uses that font to depict 
the characters present in your DOS text screen capture. Use the Fonts option in the 
Windows Control Panel, or the HJSetup icon to run a Workstation install of HiJaak Graphics 
Suite to make the font available to Windows. If this doesn't work, re-install HiJaak PRO.

Q. Why do I occasionally see a black line across the top of DOS text screen 
captures that have been converted to BMP?

A. A typical DOS text screen capture will show gray text on a black background. In 
converting this screen to BMP and processing it to a black text on white background 
(using the Reverse Black and White option), a black bar may be introduced across the 
top of the image. To achieve the same clean black on white appearance without the line, 
you may choose to use the Change a Color selection under the Colors selection from 
the main menu to map the black background to white. The gray text may then be 
mapped to black by the same process.



DOSCAP error messages
Q. Why do I get the error message "Card Undefined" when using the DOSCAP 

utility?
A.  You will get the "Card Undefined" error when you have not set up DOSCAP in HiJaak PRO. 

Pull down the Capture menu and select DOS Capture Options (Alt+c, d).    From the 
Graphics Card area, select the appropriate card type (Alt+g, arrow), and try DOSCAP 
again.



If all else fails... 
...you can use ALTCAP, an alternate DOS capture utility. This utility only works for standard 
VGA screens only.

Use ALTCAP as follows:
1.    At the HJPRO DOS prompt, type ALTCAP.EXE. ALTCAP will "expand" into the following files:

CAPTURE.EXE
HJ02.EXE
VGA.EXE
HJ.SET
FREEALT.COM
ALTCAP.TXT

2.    When you want to capture a DOS screen, either shell out to DOS or exit out of Windows.   
Switch to the HJPRO directory.

3.    At the DOS prompt, type CAPTURE. You will see a simple instruction screen. Note that the
default hotkeys are Left Shift-Left Ctrl.

WARNING: Do not run DOSCAP at the same time as you run this alternate capture 
procedure.

4. Run the application that has the screen you want to capture, and bring up that screen. 
Press the Left Shift-Left Ctrl keys at the same time.

5. You will see a menu prompting you to select either Screen, or Printer. Use the arrow 
keys to select, and press Enter.

6. You will hear a beep indicating that the Screen has been captured. At the Save prompt, 
type the path and filename where you wish the captured file to be saved.    Press Enter.

7. You will return to the Screen or Printer menu.    When you are through capturing, press 
Esc.    Your captured screens will be saved in PIX format in the directory that you selected.

8. Use HiJaak PRO to convert the *.PIX file to another format.



Problems running DOSCAP
Q. What should I do when DOSCAP locks up my applications?
A. DOSCAP might lock up your applications if you are running DOSCAP with another 

Terminate and Stay Resident program (TSR) or another program that uses EMS.    A TSR is 
a program that runs in memory, waiting for you to signal it to start by pressing a certain 
combination of keys or by running a command.    
To stop your applications from locking up, change your Maximum EMS Usage setting: pull 
down the HiJaak PRO Capture menu and select DOS Capture Options (Alt+c, d). You 
will see the DOS Capture Options dialog box.    In the Max EMS field, type 0 (zero) 
(Alt+m, 0). 

Q. Why won't DOSCAP run?
A. DOS Capture is incompatible with certain configuration.

DOS 5.0 EMM386.SYS: EMM286.exe emulates expanded memory with extended 
memory and managers the upper memory area. The FRAME option in the CONFIG.SYS file
allows you to specify the location of the page frame. If that options is assigned the value 
FRAME=NONE, only Upper Memory Blacks may be used, rather than EMS. This 
configuration is incompatible with DOS CAP and will cause a system crash. 
QEMM: QEMM may also be incompatible with DOSCAP. In the CONFIG.SYS file, make sure 
that the line with QEMM386.SYS does not have the NOEMS parameter. If it does, remove 
this parameter and reboot.



Error Messages

The following are some of the most common error messages in HiJaak PRO. Click on the error that you 
need help correcting.
Warning 2 --   PCL  :   The Source could be in PCL 5
Warning 8 --   GIF  :   This image may contain text that cannot be displayed.
Error -- 101: Couldn't allocate virtual memory.
Error -- 298: Resource was not found. Please reinstall.
Error -- 1002: Source file type is unsupported.
Error -- 1003: Source file doesn't match type. Different flavor.
Error -- 1005: Font file not found or CONFIG.SYS FILES= too low. Try FILES=40 and make sure font is in 
your WINDOWS directory.
Error -- 1009: Bad font file. Try running RESETPCL from the DOS prompt, or reinstall.
Error -- 1020: Can't find resource in CVT.RES file. Please reinstall.
Error -- 1025: Internal error.
Error -- 1032: Image cannot be displayed in this video mode.
Error -- 1036: Missing a DLL.



Warning 2: This warning appears if HiJaak PRO detects information in the file that may be PCL 5. Certain 
elements are the same in both PCL 4 and PCL 5 files; however, HJDT only supports PCL 4 files. If the 
conversion fails or is inaccurate, it may be because the file contains PCL 5 information.



 Warning 8: This warning indicates that text in the GIF file may not appear when the file is opened. This 
refers to ASCII text, as opposed to text that has been rasterized and is part of the raster image. The file 
will still open.



Error 101: This error occurs if there is no more space on your hard drive for temporary files. Free hard 
disk space by deleting or moving files from the hard drive.



Error 298: If HiJaak PRO is missing a resource file, it will not run. You must reinstall to add that file. If you
do not want to lose your settings, copy the set file to a new location before reinstalling.



Error 1002: This error occurs if the file extension is not recognized by HiJaak PRO. If HiJaak PRO 
doesn't recognize the extension, it will not open the file. If you know the file type, check the table of 
Supported Formats to see if it is supported. If the file type is supported, you can change its extension, 
thereby allowing HiJaak PRO to open it: rename the file using HiJaak Browser and give it an extension that
HiJaak PRO will recognize. If the file still does not open, it is probably not in a supported format.



Error 1003: This error may occur for one of the following reasons:
The file type may be different from that which is indicated by the extension. HiJaak PRO assumes 
that the file extension of a file represents the actual file type. However, this may not always be the case. If
a file has an extension that does not represent the file type, HiJaak PRO will not read the file correctly and
you will receive this error. You need to find out how the file was created in an effort to discover the file 
type. When you discover the file type, check the table of Supported Formats to see if it is supported. If the
file type is supported, you can use HiJaak Browser to change its extension, thereby allowing HiJaak PRO 
to open it.
The file may be corrupt. Check the file by opening it in another application. If the file does not open, 
it is probably corrupt. If it does open, the file type is probably different from what is indicated by the 
extension. You need to find out how the file was created in an effort to discover the file type. For example,
the file may have been saved with the wrong extension. When you discover the file type, check the table 
of Supported Formats to see if it is supported. If the file type is supported, you can use HiJaak Browser to 
change its extension, thereby allowing HiJaak PRO to open it.



Error 1005: This error may occur for one of the following reasons:
HiJaak PRO must have access to the Arial TrueType Font. If it does not, this error will occur. You may 
have to enable TrueType fonts. To do this, open the Control Panel and double-click on the Fonts icon. You
will see the Fonts dialog box. Click on the TrueType button. You will see the TrueType dialog box. Select 
the Enable TrueType Fonts checkbox. Click on OK. Click on Close.
File does not contain sufficient font information. The file may contain a reference to a font, but not the
actual font information. Reprint the PCL file and set the printing application so that it includes all print 
information in the PCL file. For more information see, the printing application's documentation. 



Error 1009: Before you reinstall HiJaak Graphics Suite, be sure to copy the set file to another location. 



Error 1020: Before you reinstall HiJaak Graphics Suite, be sure to copy the set file to another location. 



Error 1025: This error may occur if the set file is corrupt. If you receive this error, you need to load the 
default HiJaak PRO settings. Select Load Settings from the Setup menu and click on the Defaults button.



Error 1032: This error may occur if the DISPTYPE value is invalid. Select Display Type from the Setup 
menu. In the Display Type dialog box, select the red rose that looks the best.



Error 1036: If HiJaak PRO is missing a DLL, it will not run. You must reinstall to add that DLL. If you do 
not want to lose your settings, copy the set file to a new location before reinstalling.





Macintosh Files

Description and Use of This Procedure
This procedure describes how to move graphics files from your PC over to your Macintosh computer. 
Moving files to the Macintosh can be done in several ways. The following procedure is one way that only 
uses software provided with the Macintosh itself. If you plan to do a large amount of file transfer between 
platforms, an Apple dealer can recommend software that will automate this process. 

If you have successfully move the file to the Macintosh, but cannot open it in your application, you may 
need to change the file's type code. For more information, click on the following:
Changing a File's Type Code

Move the file onto the Macintosh Hard Disk as Follows:
1. Create a file using HiJaak which is compatible with the application in which you plan to use it. If you are

not sure which format to use, PICT (.PCT) and TIFF (.TIF) are two of the most common formats used 
in Macintosh applications.    Please note that there are several different flavors of both PICT and TIFF, 
and some may not be compatible with applications that read those formats.    For more information on 
flavors, click on the following:
Flavors

2. Copy the file to a DOS formatted 3.5" floppy disk.
3. Take the floppy to the Macintosh. Before inserting the disk in the Macintosh, run the Apple File 

Exchange program.
Note: Apple File Exchange is a program that allows certain Macintosh floppy drives to read and 
write PC disks.    If you do not have this program on your System disks, contact your Apple dealer 
to check the compatibility of your Macintosh drive.

4. Once Apple File Exchange is running, insert the floppy in the Macintosh. The program window will be 
split into two parts:    one for the floppy and one for the Macintosh. First, select the folder on the Mac 
disk in which you want to copy the file. Next, select the file from the PC disk to be copied, and click the 
Transfer button in the middle. Once you are finished copying files, click the Eject button to eject the 
disk, then select File/Quit to close Apple File Exchange. Your file should now be on the Macintosh hard 
drive.

You should be able to open this file in your application. If the file does not show up in the application's 
Open dialog box, you will need to edit the file's type code to make it compatible with your application. 
For instructions on editing a file's type code, click on the following:
Changing a File's Type Code



Changing a File's Type Code

Description and Use of This Procedure
This procedure described how to edit a file's type code to make it compatible with your Macintosh 
application. Use this procedure if you have transferred a file to the Macintosh, but are unable to open it in 
your application.

Change a File's Type Code on the Macintosh as Follows:
1. Copy the file from the floppy to a Mac hard disk. 
2. Open ResEdit. This is a utility distributed by Apple. It comes on certain versions of the Macintosh 

System disks.    If you do not have it, contact your Apple dealer.    here are other utilities that can also 
change a file's Type code.    f you'd prefer to use one, consult the program's documentation and the 
table of Type codes shown in step 3 below.

3. In ResEdit, select File/Open.    Select the name of the file you want to work on.    Click OK.    If ResEdit 
asks for confirmation about adding a resource fork to the file, click OK.    The resource fork is needed 
for the file to work in some Macintosh applications.

4. Select File/Get Info for filename. This will bring up a box which contains information about the file. 
There will be two text fields named Type and Creator.    These are what need to be edited.    Highlight 
the text in the Creator field and delete it, leaving the field blank.    For the Type code, delete the text in 
the field and replace it with the appropriate code for the type of file it actually is from the list below.    
Note that all codes must be in all uppercase and have no spaces.

If the file is a the correct Type code is...
TIFF (*.TIF TIFF
PICT (*.PCT) PICT
EPS (*.EPS, *.AI) EPSF
MacPaint (*.MAC) PNTG

        Once the codes are correct, select File/Save, then File/Exit. The file should now show up in your 
application's File..Open dialog box and be readable in your application. If you have a file whose Type 
code is not listed above, create a file of the same format in your application, and follow steps 1-3 
above. Instead of changing the Type and Creator codes, however, note the Type code and then select 
File/Exit without changing anything. That Type can then be used when working on file of that format 
from the PC.



Opening

Q: Why does HiJaak PRO GPF when I click on File / Open?
A: If HiJaak PRO finds outdated DLLs in the WINDOWS\SYSTEM directory, this might happen. These 

older DLLs appear because some applications copy older DLLs into the WINDOWS\SYSTEM 
directory. To solve this problem, exit Windows and switch to the    WINDOWS\SYSTEM directory.
Type your path to HJPRO, followed by \REDIST.EXE -o. For example, if you have not changed the 
default install directory for HiJaak PRO, you would type:C:\HJPRO\REDIST.EXE -o
This will copy the latest DLLs into your system directory and should solve the problem.

Q. Why can't I open ICO files?
A. There is a known bug in HiJaak PRO with opening 256 color ICO--Windows Icon files. Call Inset 

Technical Support to see if a fix is available.



Conversions and Formats
For help with conversions, click on the format below that you are converting to or from:
BMP
CGM
GEM
IGF
JPEG
PCL
TIF
TXT

If none of the above topics apply, click on the following:
General conversion problems



BMP
Q. Why have I noticed the file sizes of some BMP files increasing when I use HiJaak

PRO's RLE compression for that format?
A. The RLE compression type is effective only when a BMP image has a large number of 

similarly colored dots (or pixels) in close proximity to each other. Other types of BMP files 
may not be compressed at all when the RLE flavor of BMP is selected, and some may 
actually grow in size.

Q. Why do I occasionally see a black line across the top of DOS text screen 
captures that have been converted to BMP?

A. A typical DOS text screen capture will show gray text on a black background. In 
converting this screen to BMP and processing it to a black text on white background 
(using the Reverse Black and White option), a black bar may be introduced across the 
top of the image. To achieve the same clean black on white appearance without the line, 
you may choose to use the Change a Color selection under the Colors selection from 
the main menu to map the black background to white. The gray text may then be 
mapped to black by the same process.



CGM
Q. What can I do if all my CGM images look all or partially black?
A. Open the C:\WINDOWS\HJPRO.SET file in an ASCII editor such as Notepad. Search for the 

following line: ??????BVIS=ON. Beneath that line, type the following: CGM???BVIS=OFF. 
Save the HJPRO.SET file.

Q. Why does my CGM image open with a background color different from the one I
have selected in Preferences? 

A. All CGM images have background color information built directly into the file. If you open 
an image like this, HiJaak PRO will view it with the file specified background color, rather 
than the one you selected in the Preferences dialog box.



GEM

Q. Why does my conversion to GEM create an image with incorrect colors?
A. The GEM format uses a fixed color palette, so conversions from formats without the same

palette limitation may produce undesired color changes in GEM. To remedy this problem, 
use HiJaak PRO's Change A Color option under the Colors menu to remap colors in the 
source image to the desired colors in the fixed GEM palette.



IGF

Q. How might I speed up the conversion of text screen capture IGF files to other 
formats?

A. The conversion of text screen capture IGF files to other formats will be particularly time-
consuming when the captured screen includes the dotted text characters often used in 
screen backgrounds and shading. Each dot in those characters must be mathematically 
calculated and positioned by HiJaak PRO during a conversion. To speed the conversion, 
select Rasterize Text from the DOS Capture Options screen accessed through the 
Capture menu selection. Then try the screen capture again. This will cause DOSCAP to 
take a bitmapped picture of the objects on your DOS text screen and will eliminate the 
need for much of HiJaak PRO's conversion calculations.

Q. My DOS text screen capture does not include any peculiar shading characters 
or anything that should hold up the conversion process. Why else might 
conversions from text IGF files take too long?

A. Through the course of revising the text IGF format for this release of HiJaak PRO, two 
separate fonts were created by Inset Systems. The first, IBMPCMED, was made available 
to users of HiJaak for Windows 1.0 to remedy some text screen capture problems that had
been encountered and was also included in some pre-release testing of HiJaak PRO 
Version 2. That font was later replaced by IBMPCDOS, a TrueType font. If you are among 
those users who received IBMPCMED, it is possible that the presence of that font is 
slowing down IGF conversions and hurting the quality of those conversions. Check for the 
presence of the font using the Fonts selection under the Windows Control Panel. If you 
find IBMPCMED, remove it using the appropriate Control Panel button. Control Panel also 
provides you the option of deleting the font from your hard drive. We suggest you do so. 
The installation of HiJaak PRO should place the newer IBMPCDOS.TTF into your list of 
available fonts. Using this font, HiJaak PRO will be able to give you the best quality 
conversions of your DOS text screen captures in the least time.

Q. How can I avoid a Font File Not Found error message when converting from a 
text screen capture IGF file?

A. That error message should only occur if the font IBMPCDOS.TTF was not properly installed
into Windows during the HiJaak PRO Setup process. HiJaak PRO uses that font to depict 
the characters present in your DOS text screen capture. Try adding the font using the 
Fonts option in the Windows Control Panel. If that doesn't work, reinstalling HiJaak 
Graphics Suite should make the font available to Windows. 

Q. How can I change an IGF file from Color to Black and White?
A. Pull down the Setup menu and select Load Settings. Click on the Defaults button.
2.    With the IGF image that you want to change open and active, pull down the Colors 

menu and select Change a Color. 
3. Click on the object in the foreground that you want to change to black (ie text).    You will 

see the Colors dialog box. Select black.
4. Repeat step 3 for every color in the foreground that you want to appear black (i.e. text 

and borders).
5. Use Change a Color to change the background to white.
6. Once this is complete, close the IGF image down WITHOUT saving it.    (DO NOT SAVE THE 

IMAGE AT THIS POINT.)
7. Reopen the IGF image. Pull down the File menu and select Save As. You will see the 

Save As dialog box.
8. Select the format to which you want to save the IGF file (i.e. PCX) Click on the Options 

button. You will see the Options dialog box.
9. Click on the List Color Changes button.    You will see the List color Changes dialog 



box. Verify that the changes you had made are there and correct and then click on the 
Apply Color Changes check box.    Click on OK

10. Click on the Reduce Colors button. You will see the Reduce/Expand Colors dialog 
box. In the Number of Colors field, select    Black and White.    In the Reduction 
Method area, select Snap.    Click on OK.

11. Click on OK two more times to start conversion. Open the converted image and it should
have a black foreground and white background.

12. Once the conversion is complete, select Save Settings from the Setup menu. Save the 
options you set in a set file. For more information on saving settings, click on the 
following:

Set Files



JPEG

Q. What are the size limitations for Lead JPEG DLL Pegasus JPEG?
A. The size limitation for LEAD is 1365 pixels wide. The size limitation for Pegasus is 2730 

pixels wide.

Q. Why is there a width limitation when converting to the JPEG format?
A. The Lead DLL used in conversions to JPEG may generate an error message if the image 

being produced is greater than 1,365 pixels in width. The conversion will work properly if 
sizing values, set on the Options menu, are kept to a width less than 1,365 pixels. 
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 PCL
Q. Why does my PCL image have incorrect fonts? What does the Font File Not 

Found error message mean?
A. PCL 4 files, such as those supported by HiJaak PRO, generally contain all information that 

a LaserJet II compatible printer will require for accurate printing and will show up with 
correct fonts in HiJaak PRO. However, some applications keep important font information 
separate from the document information. Those applications will produce incomplete PCL 
files that will probably not function as expected in HiJaak PRO and may cause a Font File 
Not Found error message during conversion. For these PCL files to function properly, it is 
important to enter the Source PCL Options screen at the beginning of a PCL conversion 
and download the appropriate font files into HiJaak PRO. Downloading of fonts into HiJaak 
PRO will usually not be required for a successful PCL conversion as fonts are typically 
included in the PCL file itself.

Q. What can I do to avoid conversion failures and missing characters when 
converting from a PCL file?

A. Previously stored font information may prevent HiJaak PRO from successfully converting a
source PCL file. A RESETPCL.BAT utility, installed in the HJPRO directory, allows for the 
clearing of old font information. To use the utility, exit HiJaak PRO and go to a DOS 
prompt. Type RESETPCL with the path to your Windows directory (typically, C:\
WINDOWS) as the command line parameter.



TIF
Q. When I use HiJaak PRO's Copy As command and select the TIFF format, I get an 

error when I try to paste into my application. How can I successfully select a 
format and paste an image?

A. Since some applications cannot read TIF from the Clipboard, you should select another 
format.    In the Select Clipboard Format dialog box, select Windows DIB. This should 
consistently give you good results.



TXT
Q. Conversions of Text files to CGM result in a zero-length file or an empty image. 

What can I do to get a successful conversion of TXT to CGM?
A. Text to CGM conversions produce blank images or zero-length files when the conversion is

done with the Stroke Fonts option set to On. To correct the problem, de-select the 
Stroke Fonts option.



General conversion problems
Q. Why does my image file become corrupted when I am doing a conversion from 

that source to an identically named file in the same format?
A. During conversions, HiJaak PRO reads the image information from the source file, 

processes it and then saves it to the destination file. If the source and destination files 
have the same path and name, HiJaak PRO will be forced to save information into a file 
from which it still needs to read information. This activity may corrupt the file. Selecting 
the Overwrite Notification check box in the Save As and Convert To screens will 
provide a warning when existing files are about to be overwritten. Changing the path 
and/or filename of the destination will prevent the corruption of the source file.

Q. When I try to convert a file, HiJaak PRO goes into an endless loop and I have to 
reboot. What can I do to prevent this?

A. HiJaak PRO will go into an endless loop if the buffer size is less than one scanline of data. 
To fix this problem, pull down the HiJaak PRO Setup menu and select Configure Convert
(Alt+s, c). You will see the Configure Convert dialog box. In the Buffer Size area, 
increase the current value (Alt+b). For example, if your current buffer size is 16,000, 
enter 20,000 and try the conversion again. You can increase your buffer size up to 
64,000.



Scaling and Resizing

For tips on scaling and resizing your images in HiJaak PRO, click on one of the following:

Changing the size of an image
Preventing distortion while scaling or resizing
Getting the best print-outs when scaling
Scaling the view



Changing the size of an image

Q. How can I scale an image to be two or three times the size of the original?
A. HiJaak PRO allows for this type of scaling through the Multiples selection under Units in the Resize 

dialog box. Once Multiples is set as the unit of scaling, the image will be scaled a number of times 
equal to the values placed in the width and height fields. For example, entering 2 in the width field and 
2 in the height field will produce an image that is double the size of the original.

Q. How can I size an image to match the dimensions of my screen?
A. Selecting Fit in Display Width from the Resize dialog box will scale your image to be precisely as 

wide as your display screen. It will preserve the proportions of your original image. Selecting Fit in 
Display will scale your image to be precisely as wide and as tall as your display screen. If necessary, 
this scaling option will distort the width to height proportion of the original image.



Preventing distortion while scaling or resizing

Q. How can I prevent stretching or squashing of my image when I resize it?
A. Stretching or squashing of an image may occur when the height and width values entered by the user 

are not in the same proportion as the width and height of the original. The Maintain Aspect Ratio 
selection on HiJaak PRO's Resize dialog box ensures that the proportions of the original image are 
preserved during scaling.



Getting the best print-outs when scaling

Q. What scaling options should be used on my image to ensure the best quality printing?
A. When scaling an image for printing, select horizontal and vertical resolutions that match those of your 

print device. If the image was to be printed on a typical laser printer, for example, the resolutions 
should be set to 300. After setting the appropriate resolutions, the width and height fields should be 
filled in with the dimensions desired in the printed output. Selecting Maintain Aspect Ratio will ensure
that the proportions of the original image are preserved while the image is being scaled.



Scaling the view

Q. Why do the scaling options "Page in Width" and "Scale to Window" not work with DOS text 
screen captured IGF images?

A. Due to limitations inherent in the rendering of Windows TrueType fonts, HiJaak PRO does not support 
the use of those scaling options for text screen IGF files.



TWAIN
For advice on problems with HiJaak PRO's TWAIN support, click on one of the following:

TWAIN doesn't work at all
I can't get TWAIN to work with my Nisca Spectra scanner



TWAIN doesn't work at all
Q. Why are HiJaak PRO's TWAIN Select Source and Acquire options grayed out?
A. Those options, found under the File menu selection, will be grayed out if you do not have

any TWAIN devices (scanners supporting the TWAIN protocol) installed. The installation 
procedure for TWAIN devices make certain device drivers, files with .DS extensions, 
available to Windows and enable the selection of the Select Source and Acquire options.

Q. Why doesn't TWAIN work on my computer system?
A. Some TWAIN device drivers will make use only of conventional memory. If there is not 

enough conventional memory available, TWAIN will not function. Eliminating other device 
drivers and TSRs, programs that load into memory and stay there waiting to be activated,
will free up some additional conventional memory.



I can't get TWAIN to work with my Nisca Spectra scanner
Q. How can I troubleshoot TWAIN problems that I am having with my Nisca 

Spectra scanner?
A. In general, it would be best to refer all difficulties related to the scanner to its 

manufacturer. However, during testing of HiJaak PRO the answers to some common 
problems were discovered:
"Cannot read from device HH$SCAN" indicates that the device driver for your scanner
has not been loaded or that you have configured it for a serial port that is not available on
your computer system. This error message may also be the result of setting the device 
driver to run at too high a baud rate.
"Can't get data from scanner: couldn't allocate secondary scan buffer" indicates 
that there is insufficient conventional memory available. Free additional memory by 
eliminating running programs, other device drivers or TSRs, programs that load into 
memory and stay there waiting to be activated.
"Couldn't initiate scan. Reduce scanning speed" indicates that the scan dimensions 
are in an indeterminate state. To correct the problem, set the dimensions to 4.0 inches by 
6.0 inches in the Nisca Acquire Source dialog box. Use the mouse to drag the image 
display frame to those exact dimensions. After initializing the scan image display frame in
this manner, the frame can be successfully adjusted to the size you wish.



Text and Fonts
For advice on dealing with known problem areas related to text and fonts in HiJaak PRO, click
on one of the following:

Change a Font is not working properly
How can I change text and fonts in DOS text screen captures
I'm having problems with fonts in my PCL files
Text in my ASCII TXT file looks wrong
Text in my DXF file looks wrong



Change a Font is not working properly
Q. Why is my text not resizing to where I drag the selected text handles when 

using the Change a Font option from the Edit menu?
A. In order to maintain readability, Windows 3.1 snaps the font size to a given size closest to

your specification.    This is primarily a function of Windows 3.1 and will be only slightly 
larger or smaller than your specification. Note that if you change font size in CGM files, 
only height is taken into account.    That is, if you change height of the font, the width will 
change to maintain aspect ratio; if you change the width, nothing will happen.

Q. Why isn't my text file viewing properly in HiJaak PRO?
A. When viewing a 132 column mode text file, you must use the Change a Font option 

from the Edit menu to select the text and scale it down to fit on the screen.



How can I change text and fonts in my DOS text screen capture?
Q. How can I change fonts in a DOS text screen capture?
A. HiJaak PRO does not currently permit the changing of fonts in a DOS text screen capture. 

In order to change the font, convert the image to the TXT format first. Font changes will 
be possible for the converted image file.



I'm having problems with fonts in my PCL files
Q. Why does my PCL image have incorrect fonts? What does the Font File Not 

Found error message mean?
A. A PCL 4 file, such as those supported by HiJaak PRO, generally contains all information 

that a LaserJet II compatible printer will require for accurate printing and will show up with
correct fonts in HiJaak PRO. However, some applications keep important font information 
separate from the document information. Those applications will produce incomplete PCL 
files that will probably not function as expected in HiJaak PRO and may cause a Font File 
Not Found error message during conversion. For these PCL files to function properly, it is 
important to enter the Source PCL Options screen at the beginning of a PCL conversion 
and download the appropriate font files into HiJaak PRO. It is important to note that 
downloading of fonts into HiJaak PRO will usually not be required for a successful PCL 
conversion as fonts are typically included in the PCL file itself.

Q. Why does a "Font File Not Found" error message appear when I attempt to 
open a valid PCL 4 file into HiJaak PRO?

A. Even when the PCL file is valid and contains all necessary font information, HiJaak PRO 
may generate a font error message if the PCL interpreter files were not installed with the 
rest of the product. This would most likely be the result of a Custom Install, in which the
HP PCL 4 Interpretation option was not selected. To enable conversion of PCL files, 
reinstall HiJaak PRO using Full Install or be certain to select the HP PCL 4 
Interpretation option in the Custom Install.

Q. What can I do to avoid conversion failures and missing characters when 
converting from a PCL file?

A. Previously stored font information may prevent HiJaak PRO from successfully converting a
source PCL file. A RESETPCL.BAT utility, installed in the HJPRO directory, allows for the 
clearing of old font information. To use the utility, exit HiJaak PRO and run RESETPCL with 
the path to your Windows directory (typically, C:\WINDOWS) as the command line 
parameter.
You can also fix this problem by opening the Printers selection in the Windows Control 
Panel. Click on the Use Print Manager check box (Alt+u) to disable the Windows Print 
Manager.

Q. How can I avoid the change in font that occurs when I rotate my PCL file?
A. The PCL4 used by HiJaak PRO in emulation of the LaserJet II does not provide for the 

rotation of fonts. HiJaak PRO substitutes an already-rotated font whenever text in a PCL 
file is rotated. That may cause the look of the PCL file to change. To avoid the change in 
font, convert the PCL file to PCX and then back to PCL. The conversion through PCX will 
cause text to become bitmapped representations of the original font. Subsequent rotation
of the PCL file will not change the appearance of the text.



Text in my ASCII TXT file looks wrong
Q. When I am viewing an ASCII TXT file, the font in my TXT file is incorrect and 

extends beyond the border of the window.    How do I correct this?
A. Your set file has probably been corrupted.    Pull down the Setup menu and select Load 

Settings.    In the Load Settings dialog box, click on Defaults.    Click on OK.    Re-start 
HiJaak PRO and open your TXT file again.

If this doesn't work, check in the Windows Control Panel Font utility to make sure you 
have TrueType fonts enabled.    If they were not, enable them and try again.

If this doesn't work, then the IBMPCDOS font that HiJaak PRO expects to read has 
probably been deleted from your HJPRO directory.    Double-click on the HJSetup icon and 
run a Workstation install to re-add that font, and try again. If that doesn't work, you will 
have to re-install HiJaak PRO.



Text in my DXF file looks wrong
Q. The fonts in my DXF file don't look right. What can I do to correct them?
A. If the fonts in your DXF file are out of place, the wrong size or the wrong font, open the 

DXF file in AutoCAD and use the "Explode" command. This command will change the font 
into line segments, which should display properly.



Trace

Trace
Q. Does Trace require a math co-processor?
A. To use the Bezier Generalization option, your computer must have a math co-

processor. Otherwise, none is needed.

Q. When I trace an IGF file using Centerline, the traced image looks bad. What can I do to make 
the traced image look better?

A. Before tracing, convert the IGF file to another format such as BMP or PCX. 

Q. When I trace an image, why do I lose so much detail?
A. The Trace options are designed to create smaller files. The only way that the options can 

accomplish this is to eliminate some of the detail in the original image. Try different 
combinations of options to retain as much detail as possible. For example, if you select 
the Large Speck Removal option, you will lose detail. Try the Medium Speck Removal
option and reducing the number of colors instead.
If you are using the Centerline method of Trace, always use Small Speck Removal ro 
you may lose entire lines.
Also, sometimes, when you have a very low-resolution image, especially with thin text, 
setting any generalization tolerance other than 0 result in unacceptable data loss, while 0
results in an unacceptably large file. However if you scale up the image (say, 2 to 1) and 
then apply some blurring (like 2x2 Undither), and then tracing, you get good results. 
Notice that you can apply Undither to images with no dither in them.

Q. When I trace a 24-bit raster image or a dithered image, the file size becomes very large. What 
can I do to reduce the file size of the traced image?

A. Tracing a 24-bit or a dithered image results in a larger file because there are many 
isolated pixels in theses types of images that HiJaak PRO must trace individually.
There are 3 Trace options you can use to help with this situation:

1:    Reduce the number of colors in the original file to any power of 2 from 1 to 8 
(2 to 256 colors).

2.      Undither the image: To properly use this option, you have to know the size of 
dither matrix. You can tell what the dither size is if you zoom in very close to some 
light dither and try to count up how many pixels across the pattern is.    Use this 
number in the Undither area of the Trace Options dialog box. If you use the wrong 
size, instead of getting small squares around the isolated pixels in the dither pattern, 
you just get larger squares.    

Note: For images that use diffusion, there isn't any pattern: you'll probably have 
to try them all to see which is best.    
Note:    If you use the largest Undither option (4x4), many times the image 
becomes unacceptably blurry.

3:    Use Speck Removal on the image. This option checks the neighboring pixels of a
given pixel to see if any of them are the same color as the center. If so, nothing 
changes. If not, the pixel is replaced with the most common color in the grouping. 
The Small option checks the 8 neighboring pixels. 
The Medium option checks a 5x5 region.    First if there are any pixels in the 
outermost ring of 16 pixels that are the same color as the center, the pixel is not 
changed. If not, the 8 pixels in the inner ring are checked. If any pixels are the same 
as the center, it's left alone.    If neither of these cases is true, the center is replaced 
with the most common color of the 24.
The Large option checks a 5x5 region. The center pixel is always replaced with the 
most common color. This option will not preserve fine detail or thin lines. If these are 
present in your image, do not use the Large Speck Removal option.





Import into Other Applications
The topics below gives information on troubleshooting when you are using HiJaak PRO with 
other applications through the application's Place or Insert command or OLE. Click on the 
application below for which you want troubleshooting help or tips:

PageMaker 4.0 and 5.0
MS Word for Windows
WordPerfect
Ventura Publisher for Windows

Note: If you are running Windows in standard mode, you will not be able to import 
image files larger than one megabyte. If you need to import a larger image, try 
running Windows in enhanced mode.



PageMaker 4.0 and 5.0

Q. Screen captures brought into PageMaker as TIFF images sometimes come in 
with black and white reversed. What can I do to fix the image?

A. Selecting Image Control under PageMaker's Element menu will allow for brightness and 
contrast and other adjustments to your placed image. Selecting a contrast of -50 will 
reverse black and white in your image.

Q. Why do my images look bad when brought into PageMaker 4.0?
A. On-screen image quality is controlled in PageMaker through the Edit menu's 

Preferences selection. The best on-screen quality will be achieved when the Detailed 
Graphics option is set to High Resolution. Still, images may appear to be missing 
details when viewed from within PageMaker. However, this is merely the result of 
PageMaker's on-screen presentation of an image rather than a deficiency in the image 
itself. All details should be seen when the image is finally printed from PageMaker.



Word for Windows
Q. When I try to link a HiJaak Object into Word for Windows, the linked image 

looks very poor or it doesn't link at all. What should I do?
A. When you link a HiJaak Object in Word, you must select Picture or Device Independent 

Bitmap in the Data Type dialog box; do NOT select HiJaak Object.

Q. Why do I get the "Help for WordPerfect Users" message box when I hit the 
hotkeys to capture a Microsoft Word 6.0 window?

A. If you are using any of the function (F1-F10) keys as your hotkeys for Windows screen 
capture and you want to capture a from a Word for Windows 6.0 screen, the "Help for 
WordPerfect Users" message box will always come up. This is because Word uses the 
function keys as a call to the help. To work around this, change your HiJaak PRO hotkeys 
to Ctrl-Shift-c, or use the Word for Windows Options menu to turn off the Help for 
WordPerfect Users.

Q. What raster format will give me the best results in Word for Windows?
A. The best raster format to use with Word for Windows is TIFF. Generally, to find the format 

that will work best in a particular application just click on the Applications button in the 
Save As... or Convert To... dialog box. Select the appropriate destination application 
from the applications list, and HiJaak PRO will automatically select the best format for that
application.



WordPerfect/ WordPerfect for Windows
Q. Why does my black and white image look like a photo negative (inverted) when

I import them into WordPerfect for Windows 5.2?
A. If you are importing a black and white image using Smuggler or Copy File to Clipboard,

WordPerfect may invert your image, making it look like a photo negative. This happens 
because WordPerfect uses a fixed black and white palette. There is a 50% chance that 
any black and white image imported into WordPerfect will be inverted. To fix this problem,
select WordPerfects Graphics/Edit/Invert command.

Q. Why do my images import into WordPerfect for Windows at the wrong size?
A. By default, WordPerfect imports all images at 5.5 inches. To work around this, specify a 

size in the Maximum Height and Maximum Width areas of HiJaak PRO's Destination 
Processing Options dialog box when importing an image into WordPerfect.

Q. How can I get the best grayscale printed output of my images from within 
WordPerfect?

A. On a 300 dpi printer, the best output will be achieved from WordPerfect by using HiJaak 
PRO to convert the source file to TIFF/WordPerfect flavor with the following options: 
horizontal and vertical resolutions of 300; width and/or height equal to the desired 
dimensions of the printed image; Number of Colors set to Black and White; 
Reduction Method set to Halftone; Screen Frequency set between 75 and 90. The 
TIFF image should then be brought into WordPerfect at precisely the width and/or height 
indicated in the HiJaak PRO options. The image may display poorly in WordPerfect due to 
the patterns present in the halftone, but it will print well.

Q. How can I achieve the best black and white printed output of my text screen 
captures in WordPerfect?

A. The best results will be achieved by converting your text screen capture to the WPG 
vector format with the All Colors to Black option. No sizing options need to be selected 
for this vector conversion. The image may be scaled to the appropriate size within 
WordPerfect.

Q. Why do my image colors or tones appear incorrect when my image is viewed in 
WordPerfect DOS?

A. WordPerfect has the ability to invert image palettes. When correct palettes are inverted, 
image colors and tones will be wrong. To correct the problem, view the image in 
WordPerfect's Edit mode and select 4 for Invert On/Off.



Ventura Publisher for Windows
Q. How can I achieve the best results printing DOS screen captures from Ventura 

Publisher to my PostScript language printer?
A. Whenever possible, changing colors from dithered colors to solids will improve the quality

of an image. Then, a conversion to EPS with Brightness set to 15 should produce the 
best printed output from Ventura to your PostScript language printer.

Q. Why does HiJaak PRO produce only a grayscale flavor of TIFF for Ventura 
Publisher?

A. Grayscale TIFF generally produces better results in Ventura Publisher. For that reason the 
selection of the Ventura flavor in the TIFF Options dialog box produces only grayscale 
TIFF. Ventura Publisher is capable of displaying and printing up to 24-bit color TIFF files, 
however, the display may not look as you expect it to even though it should print 
correctly. You can use HiJaak PRO to create a color TIFF that will work in Ventura, by 
setting the TIFF Flavor option to PC Paintbrush.





Windows Capture
For advice on problems with HiJaak PRO's Windows Capture, see below:

I can't capture it...
My Windows capture doesn't look right



I can't capture it...
Q. Why am I unable to capture my application's pull-down menu with HiJaak PRO?  

Every time I hit the hot-keys to capture an area, the menu goes away.
A. When capturing a pull-down menu with HiJaak PRO, make sure that you DO NOT select 

Prompt for Options in the Windows Capture Options dialog box. The Windows 
Capture Options prompt closes the pull-down menu because Windows may have only 
one menu open at a time. Deselect Prompt for Options and use the Hotkey method to 
capture the pull-down menu.

Q. Why can't I capture an icon in one of my Windows program groups using HiJaak
PRO's Window/Object capture method?

A. Microsoft Windows 3.1 does not treat icons within program groups as separate entities, 
therefore, the Window/Object option will not outline a single icon, but only the entire 
program group. You may use HiJaak PRO's Area capture method to capture an icon, or 
you may capture the group and use HiJaak PRO's cropping feature to trim down the icon.

Q. Why can't I capture information from Hewlett-Packard's Dashboard using 
HiJaak PRO's Window/Object or Area capture methods.

A. HiJaak PRO will only capture an Area or Window/Object if your application is running in 
Dashboard's far left Extended Screen. It will, however capture any entire screen. To 
remedy this problem, either capture the entire screen using the Screen capture method 
and crop the excess information away, or move the application to the far left extended 
screen, change the view focus to that area, and try the capture again. 

Q. Why can't use Windows capture to capture screens from a DOS application 
running in full-screen mode under Windows?

A. If you need to capture screens from DOS applications, you should use HiJaak PRO's 
DOSCAP utility.    DOSCAP can be run by clicking on the DOSCAP icon in your HiJaak PRO 
program group. Also, make sure you are using DOSCAP's hotkeys (the default is Alt-Ctrl) 
and not Windows Capture hotkeys (the default is Ctrl-Shift-C).



My Windows capture doesn't look right
Q. Why do I lose the outline around my captured window?
A.    HiJaak PRO gives you the choice of whether or not to add an outline border to your 

captured window.    If you would like to include this border, then select Border in the 
Windows Capture Options dialog box.

Q. What should I do if my captured screen, area or window/object doesn't look the
way it originally did? 

A. If your captured image is completely black, has the wrong colors or just looks "funny," it 
could be related to your Windows video driver. If you experience these problems with 
HiJaak PRO's Windows capture, try using the regular VGA or the generic 800x600x16 color
video driver in your Windows Setup.



Printing
For tips on getting better results printing in HiJaak PRO, click on one of the following:

Black and white print-outs of color images
General printing tips
Printing from your applications
Printing errors



General printing tips
Q. What can I do about problems printing from HiJaak PRO to an HP DeskJet 500C?
A. The version 2.1 printer driver that was shipped with many DeskJet 500C printers may run 

into some problems. According to Hewlett Packard technical support, the 2.1 driver has 
had some problems clearing memory after it is used. That presents problems for 
subsequent uses of the driver. The most common instance of that driver defect interfering
with HiJaak PRO print jobs occurs when a HiJaak PRO print is canceled. After canceling the
print job, the 2.1 driver does not clear itself from memory and additional printing to the 
DeskJet 500C during that Windows session is impossible. HP does now provide a new 
driver -- Version 3 -- that does not have the same problems as its predecessor. That driver
is available through CompuServe or direct from HP.

Q. How can I improve the print quality of vector images that contain rotated text?
A. Rotated text within vector images is sometimes placed incorrectly in HiJaak PRO 

printouts. To ensure that the text will print properly, select Print TrueType Fonts as 
Graphics in the setup screen for your printer.

Q. What scaling options should be used on my image to ensure the best quality 
printing?

A. When scaling an image for printing, select horizontal and vertical resolutions that match 
those of your print device. If the image was to be printed on a typical laser printer, for 
example, the resolutions should be set to 300. After setting the appropriate resolutions, 
the width and height fields should be filled in with the dimensions desired in the printed 
output. Selecting Maintain Aspect Ratio will ensure that the proportions of the original 
image are preserved while the image is being scaled.



Printing from your applications
WORDPERFECT:
Q. How can I get the best grayscale printed output of my images from within 

WordPerfect?
A. On a 300 dpi printer, the best output will be achieved from WordPerfect by using HiJaak 

PRO to convert the source file to TIFF/WordPerfect flavor with the following options: 
horizontal and vertical resolutions of 300; width and/or height equal to the desired 
dimensions of the printed image; Number of Colors set to Black and White; 
Reduction Method set to Halftone; Screen Frequency set between 75 and 90. The 
TIFF image should then be brought into WordPerfect at precisely the width and/or height 
indicated in the HiJaak PRO options. The image may display poorly in WordPerfect due to 
the patterns present in the halftone, but it will print out well.

Q. How can I achieve the best black and white printed output of my text screen 
captures in WordPerfect?

A. The best results will be achieved by converting your text screen capture to the WPG 
vector format with the All Colors to Black option. No sizing options need to be selected 
for this vector conversion. The image may be scaled to the appropriate size within 
WordPerfect.

VENTURA PUBLISHER:
Q. How can I achieve the best results printing DOS screen captures from Ventura 

Publisher to my PostScript language printer?
A. Whenever possible, changing colors from dithered colors to solids will improve the quality

of an image. Then, a conversion to EPS with Brightness set to 15 should produce the 
best printed output from Ventura to your PostScript language printer.



Printing Errors
Q: Why do I get a blank page when I print from HiJaak PRO?
A: This error might occur if your set file has been corrupted somehow. When this occurs, 

close the image you are trying to print and reload the default set file by pulling down the   
Setup menu and selecting Load Settings. In the Load Settings dialog box, click on the
Defaults button. If this does not correct this problem, contact Inset technical support.



Troubleshooting HiJaak Browser
If you are having problems with HiJaak Browser, click on one of the following for more 
information:

Running HiJaak Browser
Index problems
Updating Files
Searching for files
Collections



Index problems
Q. When I open HiJaak Browser, no Index shows up and it won't allow me to open 

one. What should I do?
A. Delete the BASE.ID file from your Index directory and restart HiJaak Browser.

Q. After I moved my INDEX*.* to another directory, it doesn't work anymore. What should I do?
A. In addition to the INDEX*.* files, you must move the file DBQUERY.DB. Once you do this, your Index 

should open with no problems.

Q. My Index updates very slowly. Is there anything I can do to speed it up?
A. Make sure Windows SMARTDRV.EXE is installed and running. It should be located in your WINDOWS

directory. Updates will run much faster with this disk caching utility.



Running HiJaak Browser

Q. What should I do if HiJaak Browser causes a GPF immediately upon startup?
A. HiJaak Browser may cause a General Protection Fault (GPF) as soon as it is started if it does not fully 

support your graphics card. You can fix this by creating a set file for HiJaak Browser: Open Notepad 
and type the following line 
DIBONLY=ON
Pull down the File menu and select Save As... Save the file as C:\WINDOWS\HJBROWSE.SET. This 
should correct the problem causing the GPF. 

Q. HiJaak Browser GPFs in RDM330 when I try to run it. What should I do?
A. The HiJaak Browser Index has become corrupt. To solve this problem, go to the DOS 

prompt where you installed HiJaak Graphics Suite and type KEYBUILD followed by the 
path to your HiJaak Browser Index. If you installed in the default directories, you would 
type the following command at the C:\INSET DOS prompt:

KEYBUILD C:\INSET\BASE
          If you are using an Index other than the default, replace "BASE" with the name of your 
Index.



Searching for files

Q. Why doesn't HiJaak Browser's search find a file even when I know the file is there?
A. By default, HiJaak Browser only searches through the Index for files. This means that if you have not 

updated the file you are looking for, HiJaak Browser will not find it using search. The way to work 
around this is to specify a path in the Location area of the Search dialog box. If you specify a drive 
letter, HiJaak Browser will search through that entire drive, including subdirectories for the file. 



Updating Files

Q. When I update a large number of files, HiJaak Browser marks a lot of them Skip Update, even 
though the files are in a format HiJaak Browser should recognize. How can I change this Skip 
Update status? 

A. The Skip Update option is set in the Properties dialog box. If you have one or two files, you can 
deselect it there. If you have many files, the easiest way is to delete the files from the Index. It is 
important that you perform this procedure on the In Index area of the tree NOT the Directories area. To
do this, double click on the In Index branch of the Index tree. This area contains all files you have 
updated. In the In Index area, double-click on the directory that contains the files marked Skip Update. 
Press the Ctrl key and click on thumbnails of all the files you want to change and select Delete. This 
process deletes the thumbnails and the Skip Update setting, but not the files themselves. You can now
Update the files again.

Q. When I update my vector images, all the keywords I added previously are deleted. What can I 
do to prevent this?

A. If you want to extract keywords from a vector file and add some manually, you should perform the 
update on the thumbnail first, before you add any notes or keywords. When you add the notes, click 
on the Skip Note Update check box in the Properties dialog box to prevent HiJaak Browser from 
overwriting your changes the next time you update.



Collections

Q. Why when I try to delete a subcollection does HiJaak Browser GPF and throw me out of 
Windows. 

A. This will happen if you have recursive subcollections: For example, if you insert Collection2 into 
Collection1 as a sub collection, and then insert Collection1 into Collection2, you will have a recursive 
structure. If you delete Collection 1, HiJaak Browser will GPF. When you start up HiJaak Browser 
again, the Collections will be gone. Do not try to build these types of subcollections. 



Troubleshooting Smuggler
If you are having problems using HiJaak Smuggler, click on the topic that best describes the 
area with which you're having problems:

Running Smuggler
Importing images
Smuggler works with some applications but not others
Images imported with Smuggler don't look right



Running Smuggler
Q. Smuggler GPFs in RDM330 when I try to run it. What should I do?
A. The HiJaak Browser Index has become corrupt. This corruption causes Smuggler and 

HiJaak PRO to GPF as well as HiJaak Browser. To solve this problem, go to the DOS prompt 
where you installed HiJaak Browser and type KEYBUILD followed by the path to your 
HiJaak Browser Index. If you installed in the default directories, you would type the 
following command at the C:\INSET DOS prompt:

KEYBUILD C:\INSET\BASE.KAT



Importing images
Q. Why do some images take longer to import than others?
A. Large raster images such as TGA or PCD files takes longer to import because most 

application are not designed to handle large amounts of data through the clipboard. If you
are working with large raster images or images with many colors (24-bit), you can speed 
the import by scaling down the image or reducing the number of colors in the image.

Q. Why does Smuggler give me a not enough memory error when I try to use it to 
import an image?

A. If the image you are trying to import is a large raster file, you may get this error. Windows
Clipboard has a limitation to the size of images it can paste.    To work around this 
problem, scale the image down or reduce the number of colors and try to import again.

If you do not want to change the image quality, you can use HiJaak PRO to convert the 
image you want to import to a format that your application can read. Then, use the 
application to import the file directly.



Smuggler works with some applications but not others
Q. Why doesn't Smuggler work with my application?
A. Smuggler only works with applications that support pasting graphics from the Windows 

Clipboard. If an application does not support pasting graphics, then you will receive an 
error message when you try to use Smuggler.

Q. How can I get Smuggler to work with Word for Windows 2.0, Excel, MsMail and 
Ami Pro? The Smuggler menu item doesn't even appear.

A. Because of the way these application's menus are created, Smuggler cannot be 
appended to the end of the Edit menu. It can, however, be invoked using the hotkeys Ctrl-
Shift-S. When you want to use Smuggler to import into these applications, click on the 
Edit menu, then press the hotkeys. Note that when you are importing an image into 
MsMail, focus must be in the body of the mail message, not the Subject, To or CC fields.

Q. When I use Smuggler to import an image into Quark, no image appears. How can I get the 
image into Quark?

A. Quark requires that you draw a frame into which you can import an image. In Quark, draw
the frame and make sure it it selected.;then use Smuggler to import the image.



Images imported with Smuggler don't look right

Q. When I import images into PageMaker 5.0 using Smuggler, they look very large and coarse. 
How can I improve their appearance?

A.  After you select the file in the Smuggler dialog box, click on the Options button. You will 
see the Smuggle Processing Options dialog box. Click in the Horz. Resolution field and 
type 300. Click in the Vertical Resolution field and type 300. Click on OK to return to the 
Smuggler dialog box. In the Smuggler dialog box, click on OK to import the image.



Troubleshooting HiJaak Draw
If you are having problems using HiJaak Draw, click on the topic that best describes your 
problem:

Running HiJaak Draw
Printing From HiJaak Draw
HiJaak Draw Settings



Running HiJaak Draw
Q. When I try to start HiJaak Draw, I get an "Invalid TrueType Font" error, then a 

system crash. How can I run HiJaak Draw?
A. Every time HiJaak Draw runs, it attempts to rebuild its font table. When it has problems 

with the font table, you get this error. To correct it, open C:\WINDOWS\HJDRAW.INI. In the 
FontDLL section set the following tag:

[FontDLL]
UseFontFile=1

        This tag tells HiJaak Draw to use the existing font table, rather than rebuild it on startup.



Printing From HiJaak Draw
Q. When I print my artwork, some of the text is missing. How can I print this text?
A. Text created with the Block text tool does not print to some printers. You can change the 

printer setup so that text will print as graphics; this should correct the problem.

Print Text as Graphics as Follows:
1.    Pull down the File menu and click on Printer Setup (Alt+r). You will see the Select 

Printer dialog box.
2.    Click on the Setup button (Alt+s). You will see the Setup dialog box.
3.    Click on the Options button (Alt+o). You will see the Options dialog box.
4.    Select the Print TrueType as Graphics check box (Alt+p). Click on OK to return to the 

Setup dialog box.
5.    Click on OK to return to the Main screen. You can now print the file as usual. 



HiJaak Draw Settings
Q: How can I make sure my HiJaak Draw settings are saved?
A: HiJaak Draw settings are saved inthe HJDRAW.INI file. If they are not being saved, you can 

try the following in the HJDRAW.INI:
*    Anywhere that there is a "path=" entry, add a "\" character to the end of the path.
*    IN the default section, add the following tag:

[defaults]
saveScreenLayout=1



Troubleshooting HiJaak Paint

If you are having problems using HiJaak Paint, click on the topic that best describes your problem:

Retouch Tools
Editing Options



Retouch Tools (HiJaak Paint)

Q. Why can't select a tool from the Retouch Tool menu?
A. Make sure that the image you are trying to edit is not a 2-color image.    The retouch tools can only be 

used to edit color or grayscale images.    You can use Image/Convert To to change a 2 color image to 
an editable color depth.



Editing Options (HiJaak Paint)

Q. Why are some of the options grayed out and unavailable?
A. Some options such as the Image Filter options are not available unless you are working on a True 

Color image.    You can convert the image you are working on to True Color by pulling down the Image
menu and selecting Convert To.    In the Convert To dialog box, select True Color.    A new window will
open with a True Color copy of your image.    All of the editing options should now be available.




